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wysiwyg.   What You See Is What You Get. Seriously!

is the tagline for the launch 
of R24 -- the third and final 
installment in the trilogy.  We 

intend you to take it literally. wysiwyg previsualization and renders 
are really virtually real.  What you see in Shaded View is exactly 
what you can get on the set, in the venue or on the exterior of the 
building. 

Why is this so important?  Because your professionalism depends 
on it! 

With the new wysiwyg you get both the eye-popping images, 
appearing on screen or in the render or picture used to sell or get 
approval for the concept/project AND you know with confidence 
that you can deliver it in reality – a win-win!  With the new wysi-
wyg and the stunning images it delivers, you will not need to work 
off a pretty picture, conceived by a non-production professional, 
that is not based on industry technology so you can’t possibly 
deliver that design.  wysiwyg’s Library comprises greater than 
20,000 intelligent lights, gobos, trusses, etc, so we simply don’t 
need to cheat it!  

wysiwyg    What You See Is What You Get.    Seriously! 

R24’s new visualization raises the standard for the industry and 
uses the new and existing features.  However, even with this 
great step forward, our developmental advancements have not 
sacrificed or compromised wysiwyg’s robustness or performance.  
Significant work has taken place “behind the scenes” to increase 
its speed, especially for the new visualization.  
 
wysiwyg began as a DOS product 1994 running on a 386 desktop 
computer.  It migrated to Windows in 2002 and today runs on any 
PC computer running Windows XP or Vista (32 or 64-bit) operat-
ing systems, and on any Intel MAC Computer running via Boot-
camp or via a virtual machine. Throughout wysiwyg’s evolution, 
the consistency, integrity and reliability of previz to reality was 
paramount and evolved hand in hand with the uncompromising 
standards and growth of the Library. Over time, advancements 
to previz resulted from better visualization plus ongoing Library 
development.  We simply believe you cannot have one without 
the other. Today, wysiwyg delivers pre-visualization solutions via 

3 product levels -- Report, Design, Perform -- to meet the creative 
and delivery demands of production professionals.   

Rest assured, if you are a Lighting Designer, Director, Techni-
cian, Set Designer, Electrician, Architect, Meeting/Event Planner 
or Teacher/Instructor, we have a solution tailored to meet your 
needs. Keep in mind that our milestone advances are available on 
all levels of wysiwyg – Report, Design, Perform.
 
So for $2499 you are solidly in the game with wysiwyg Design.  If 
console connectivity is required you can step up to Perform, or if 
yours is a less complicated demand not requiring full 3D, use Re-
port.  (The only thing wysiwyg Design can’t do, compared to the 
top-of-the-line Perform, is to connect to a console, media server 
or motion control system). wysiwyg is the only comprehensive 
software solution that is built for our industry; that delivers from 
concept to design – plotting to previz (in realtime OpenGL views 
or through our offline render engine). For one price you get an 
all-in-one software solution.  One software that does it all means 
you only handle the data once (regardless of whether you make 
changes at a later stage), without translations or patches needed 
to migrate between softwares, and you get myriad efficiencies of a 
single, internally consistent, robust software solution.  
 
Go ahead.  Compare the punch of wysiwyg to the others.  Com-
pare Design’s features, look, intuitive ease; its virtually unlimited 
capacity for automated and conventional fixtures, the depth and 
breadth of the Library, the practicality and quality-options for the 
renders, its pre-visualization and accompanying Technical Sup-
port.  One low price for all that solution!  The best value in the 
market priced at $2499. One tremendous bang for your buck!  
 

So, what is R22 + R23 + R24 ? 
 
In R22, wysiwyg introduced our new enhanced beam simulation 
with soft-edge beams, accurate beam colour-mixing, lens flares, 
and animated smoke. 

In R23, we enhanced the footprint qualities of the beams with new 
footprints, accurate shadows, an optional hot spot display, and our 
new video in beam feature to display video content for DL fixtures. 

R24 = a whole new version of wysiwyg
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And now with the new features in R24, we advance our visualiza-
tion to yet a higher level, making it so really virtually real and so 
convenient that you simply don’t need to interrupt the creative 
process and go offline to render.  New LED models use a point 
source to better represent a diode for LED fixtures and LED walls.  
The intelligence underlying a Library object, for example, calcu-
lates beam intensity using the Inverse Square Law so you can 
previsualize and render accurate beam drop-off, or applies colour 
temperature data that adapts for different wattages of different 
types of bulbs.   

Keeping up with the increase in the number of productions and 
major special events being planned for the outdoors, how would 
you like to task the software to replicate various time-of-day light-
ing simulations and various outdoor weather conditions (for any 
geographical location) so you can previz your future show?   
 

Really Virtually Real 

Visualization g a picture is worth 1000 words 
		      …and can be worth big $  

Visualization has been advanced to a higher level in Shaded View 
making it so real that you simply don’t need to interrupt or stop 
the creative process and go offline to render. This advancement is 
possible because of the innovative new features.  Here are some 
of them.   

Enhanced Beams:  Enhanced beams offer a softer edge beam 
with accurate colour mixing of overlapping beams and beams 
hitting coloured objects. Lens flare can also be seen from certain 
angles. 

Improved Beam Footprints: Beam footprints now wrap around 
objects in wysiwyg as they would in the real world.  
 
Smoke:  The animated smoke and enhanced controls allow you 
to control smoke direction, speed, and density from the new Envi-
ronmental tab of the Shaded View’s, View Options dialog. 

Shadows:  Now shadows are an extension of the new foot-
prints—wysiwyg accurately determines where the shadows are 

while calculating where footprints hit objects in the scene. The 
best quality shadows will result by turning on “Soft Shadows” to 
smoothen the shadow outlines (essentially an anti-aliasing tech-
nique). And now, with CAST’s new visualization technology, shad-
ows will appear through translucent materials, such as curtains, 
creating an impressive shadow effect. 

LEDs! With new LED light sources and LED flare capability offer-
ing better representation in Shaded View, LED Fixtures and LED 
Walls look better, are more efficient and deliver better perfor-
mance.  This is an enormous advantage as LEDs are being used 
to some degree in almost every lighting design.  This also means 
that simple light bulbs and other single point light sources will be 
nicely modeled in wysiwyg.  

Inverse Square Law:  A new upgrade in R24, it calculates accu-
rate beam drop-off in visualization calculations to make the beams 
really virtually real.

For outdoor events: R24 introduces a time-of-day capability in 
Shaded View.  Use climatic or environmental conditions specific 
to the time and place (and all sorts of possible weather) specific to 
your event’s geographical location – anywhere around the world 
g any date g any time -- to test your ideas and demonstrate 
your work. Now your Shaded View presents instantly what you 
formerly had to render – instantly print your Shaded View.

 

3

ISSUE 25 /JULY 2009

R24 - Continued

New LED light source

Time-of-Day in Shaded View

Enhanced Beams and Smoke Effect introduced in wysiwyg R22
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R24 - Continued

Colour temperature: Information from our Libraries, concerning 
adapting images for different bulb wattages, is used to more ac-
curately display the photometrics of different bulbs. 

Hot Spots: Hot spots enhance visual realism and are now distrib-
uted based on the photometric data of the fixture.
 
Video in Beams (for DL fixtures capable of displaying video): 
In keeping with the increasing number of digital lighting fixtures 
capable of displaying video content, this new feature lets you 
pre-visualize videos through the fixture’s beam and footprint in 
Shaded View. 

Geometry Smoothing in OpenGL: This new shading technique 
delivers better looking sets and people, plus a performance boost.  
 
CITP Protocol for Video: This new feature allows consoles which 
support this protocol to stream video content across a network 
into wysiwyg to be displayed on a video screen or DL fixture.   

Design Tools g intuitive, logical, just what you need

Footprint Focus: Using the new Footprint Focus feature, you 
can change the footprint’s focus distance in visualize the footprint 
in Shaded Views, in effect varying the focus of the footprint from 
“hard” to “soft”. (In previous versions, footprint focus was always 
“hard”.) This feature is available for conventional fixtures (in CAD 
mode through the Fixture Properties), as well as for automated fix-
tures (in Design mode through the new Footprint Designer Tool). 
To display Footprint Focus, you turn it on in the Lighting tab of the 
Shaded View’s, View Options dialog. Note: In a future wysiwyg 
release, the Footprint Focus feature will be extended to function in 
Live Mode like all other Designer tools. 

Fixture Point of View (POV): The Fixture POV increases previ-
ous functionality to support automated fixtures and now provides 
fixture information (for example, Patch, Channel, Dimmer, etc.) at 
the bottom of the Shaded View. Now you can use the enhanced 
Fixture POV feature in conjunction with Footprint Focus to focus 
lights from wysiwyg and then provide screenshots of the desired 
footprint focus to his stage crew. 

Updates to Designer Tools: The look, feel, intuitiveness and 
ease of use have been enhanced. Many now offer more infor-
mative feedback of set values for the selected fixtures, making 
the design process a lot easier. New functionality for enhanced 
colour-mixing options (RGB, CMY, HSI) is available through the 
Colour tool. 

Ruler Tool: The Ruler tool provides a handy point of reference 
in CAD Wireframe views, enabling you to measure the objects 
that you are drawing and get an accurate idea of the distances 
between items in your plot. 

New Font Capabilities:  While working in CAD and paperwork 
you can now select TrueType fonts and styles for CAD mode 
and New Plots. On the new Font Styles tab of the User Options 
window, you can specify the font that you would like to appear 
globally in all new text labels, New Plots, and fixture layout labels. 
Mesh consolidation:  This new CAD feature lets you group se-
lected faces into one mesh to simplify the objects dramatically and 
improve overall performance. 
 
Dongle-less Background Render Manager: We have removed 
the dongle restriction currently set on the Background Render 
Manager so that you can install the Background Render Manager 
software on other computers so you can run rendering jobs from 
independent idle computers. Now you can set up as many render-
ing computers as you need to help you complete your renderings.

AutoFocus: is the protocol that wysiwyg uses to “talk back” to 
a compatible console. Using the mouse in a Wireframe view or 
using the concept shortcuts and design tools at any time, you can 
direct the console to select fixtures, set focus, and control inten-
sity, iris, and colour.  AutoFocus is connected through MIDI, Serial, 
or Ethernet. 

AutoPatch: is a protocol used by wysiwyg to transfer the patch 
hookup to a compatible console.  AutoPatch is only available in 
wysiwyg Perform. You must be connected to a compatible con-
sole for this feature to be enabled. All ports for which you want the 
patch information to be transferred must be properly bound. Only 
the hookup information in patch universes bound to the console’s 
outputs will transfer.
 
 

Library g becomes a bigger and more  
useful resource 

Comprising more than 20,000 lights, gobos, trusses, etc. the 
Library is one of its most valuable components of wysiwyg,        
often sought-after by others. From LEDs to automated lights,         
all types of fixtures from all regions of the world making wysi-
wyg  the only solution for truly international  professionals  and        
traveling  productions.  

Remember, only wysiwyg certifies that all additions to the Library 
are completely accurate and fully reliable. Many hours are in-

New features composing a Really Virtually Real Image!
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vested and a rigorous standard testing protocol is used for each 
library item to ensure model accuracy and reliability. As well, all 
library fixtures and accessories are tested in wysiwyg before we 
release them to you. New additions to the Library are added all 
the time so keep your eye on the website.  

Our discipline and the frequent addition of new lights mean  
we deliver reality so your creativity can be really virtually real.  
 
Searchable Library Browser: Ever find yourself clicking through 
hundreds of Library files in search of a fixture or that perfect item 
for your file. In the Library browser, simply click the category tab 
that you’re interested in, and then type the object name (or part 
of it) in the Search box at the top of the browser panel. All objects 
that match your query are shown. Note that on the Library tab, 
you have to select the folder in which your object is stored before 
you search. 

Numerous Library Updates:  Our enormous Library continues 
to grow with every new release of wysiwyg. At least a few times 
per year, our library department compiles the latest fixtures, truss, 
gobos,  gels -- library  objects which  are popular  in the  indus-
try -- and includes them as new items available for you from the 
Library Browser. 
 

Security & Product Levels  new options 

Improved Dongle Security System: We have improved the 
security of our products. Using better encryption algorithms for our 
dongles, we are protecting your investment and making wysi-
wyg more difficult to be tampered with by hackers. As a result, 
all dongles currently in the field must be checked to confirm they 
support wysiwyg’s new security system. For newer USB dongles 
that pass the test, an online process is available that updates your 
dongle to run with R23 and newer Releases; older USB dongles 
that fail the test (do not support the new security system) and all 
Parallel dongles must be exchanged by contacting CAST Soft-
ware for a new USB dongle. Replacement dongles are free for 
wysiwyg Members in good standing. 
 
Dongle Re-Authorization: This new initiative will help safeguard 
your dongle, ensuring that if it is lost, stolen, or found by someone 
else, the new user will only be able to work with it until the current-
ly authorized date, but never beyond.  Re-authorization requires 
that you “re-authorize” your dongle once each year by logging into 
your Member’s site, obtaining your Dongle Re-authorization Code 
and then applying this new code to your dongle. 

Dongle Leasing:  Starting with Release 24, you will have the 
option to lease your Dongle on a prepaid yearly basis. Leased 
dongles will carry the same privileges as purchased ones (i.e., 
software updates, library updates, and technical support). How-
ever, unlike purchased dongles, once the lease term has expired, 

that dongle will not permit wysiwyg to operate.  At that point, you 
can either renew the lease term or purchase the dongle. This op-
tion is more expensive than renewing your Membership but may 
appeal to those who use wysiwyg infrequently. Full details and 
pricing for Dongle Leasing will be available when R24 is launched. 
 
 
Use the power and reality of the best ... 
	 to show off your best … 

wysiwyg Demo (Dongle-less Console Viewer): To better show 
the power of wysiwyg, we have introduced console connectiv-
ity to any of our RWD’s consoles and included limited, read only 
sample files in the Demo. With wysiwyg Demo, your hardware 
can connect and display full lighting functionality with a  real 
lighting console, with cues from your console, and experience 
the value  of wysiwyg’s LIVE  Shaded View  as a  tool to  pre-
visualize a show.

R24 - Continued

YES stage lighting in R23 Shaded View 

New features composing a Really Virtually Real Image!
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R21 – Dec 07
100 NEW FIXTURES! CAST’s biggest – ever. From LEDs to automated lights, all types of 
fixtures from all regions of the world  every single fixture addition came directly from a User 
request.

Better File Sizes – LOT smaller, faster, and more manageable.
Better Holes – new Subtract/Unite/Intersect tool to do stuff like blast out a window in a wall, 
join two cylinders into one, and merge two objects.
Better Pictures – LES Wizard Image Mapping and new Image Console let you simulate low 
to medium res LED walls or curtains and apply images to arrays of light-emitting surfaces. 
(Ed: the precursor to the new LEDs).
Better Lines – choice of new Line Weight Options  improve the look and legibility of your 
plots.

R20 – July 07

R19 – Mar 07
New features let Users import from Google’s SketchUp
PLUS library object texturing; 200+ new or updated gobos; 200+ new types of truss; 145 new fixtures 
(moving, conventional, LED, and more); improved accuracy of moving lights.

wysiwyg development and innovation continues from two distinct 
approaches which work together in that the rolling forward long-
term objectives for wysiwyg development and innovation define 
the innovative new features the Releases which are delivered 
in the short-term. Accordingly, and we have big plans, currently 

under development, for the future.  As a result, consistent with the 
past years and on into the future, you can expect that wysiwyg 
just keeps getting better!

Here are a few highlights of recent Releases leading up to R22 + 
R23 + R24

it just keeps getting better

Some of our recent milestones  
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wysiwyg offers Production Professionals an unparalleled, com-
prehensive toolset. Most Users choose wysiwyg Design. If you 
need to connect to supported consoles or motion controlling de-
vices, or to use wysiwyg’s time-saving AutoPatch and AutoFocus 
features, then you need to step up to wysiwyg Perform. wysiwyg 
Report is the introductory level with limited capabilities, usually 
ideal for students or those entering our Industry.

Dealers, lighting console manufacturers or any lighting profes-
sionals can use the new wysiwyg DV (for Demo Version) for free, 
without a dongle, as a viewer to demonstrate or learn consoles, 

using one of 4 different custom built onboard sample files. DV is 
an extremely beneficial tool to use at showrooms, testing labs, 
trade shows, fairs and conventions around the world. (As always, 
connectivity occurs via CAST’s Registered wysiwyg Developer 
Program. Any of CAST RWD’s can instantly take advantage of this 
free viewer working on their equipment!)

See the Table below for a helpful comparison of the available 
wysiwyg products. For more information about these products, go 
to www.wysiwygsuite.com or contact CAST Software.

7
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it just keeps getting better !
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R24 - Continued

8



© 2009 The official bi-monthly publication for wysiwyg Members

ISSUE 25 /JULY 2009

R24 - Continued

9



© 2009 The official bi-monthly publication for wysiwyg Members

ISSUE 25 /JULY 2009
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Beta testing — committed to sustaining high standards  
while gleaning your valuable ideas for the future 

CAST’s objective for its Beta Testing Program is to uphold the 
highest level of dependability and robustness by enlisting Mem-
bers to test drive Releases, and sometimes specific innovations, 
in the field under a breadth of real conditions. CAST carefully 
monitors the Testers and ensures a reasonable cross-section of 
uses in order to optimize the usefulness of the feedback.

CAST takes Beta Tester and Member feedback very seriously. 
Dany Tancou, Technical Support Manager for CAST Software 
says, “One of my main responsibilities is helping Members solve 
unique challenges, which often translates into great ideas for 
future wysiwyg Releases. Although we get input from many 
sources, our Members are our greatest source of inspiration.”

If you’d like to be considered for upcoming Releases, please get 
in touch with Dany@cast-soft.com.

As you read this article, Beta Testing of R24 has wrapped up and 
the final tweaking and fixes are being put into R24, and tested 
prior to its release to Members.

Beta testers’ draw

On 09 Jul 09, Dino Mazza, Product Manager, and Dany Tancou, 
Manager Tech Support, put the names of all Beta Testers who 
submitted wysiwyg R24 Beta Test feedback before the contest 
deadline into a box and drew a winner. 

And the winner is..[drum roll]  Yves MANGIN, Light Designer / 
operator of Strasbourg, France.  Yves, who works in an indepen-
dent firm with a number of production professionals, wins a free 
one-year Membership renewal for his wysiwyg.

Congratulations and our gratitude to Yves and all Beta 24 Testers.

Let us introduce Yves ...

“As a Lighting Designer, wysiwyg is very important to me. My 
imagination and creativity run freely; new concepts can be tried 
and previsualized.  Without spending one Euro, I can see on my 
screen what works, tweak and produce alternative concepts or de-
cide to start over. Then at the end, wysiwyg allows me to present 
a very realistic 3D project to my clients.

The great advantage of wysiwyg is that technically, you soon 
notice all the possibilities it gives you, according to the size of the 
decoration, of the room and according to the sound. The virtual 
reality from wysiwyg and reality are very similar.  

The virtual reality to reality is easy to achieve because wysiwyg 
uses real equipment standards.  This is a huge gain of time on the 
set. I get less stress and have no anxiety about the question of 
reliability of the system.

Finally, from the perspective of the “operator”, the live mode 
function is, without any doubt, the strength of wysiwyg [that is Au-
toPatching & AutoFocus]; it saves working time on the set and for 
setting up and focusing the lights, even the advantage and time 
saving of getting the lights to operate during the rehearsal.”

 
Thank you Yves!
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CAST Software delivers high quality software solutions that are 
universal or non partisan to any particular hardware/technol-
ogy manufacturer or supplier.  We realize that many if not most 
production professionals work on a number of different projects 
(each using a different mix of equipment from different manufac-
turers/suppliers) with a number of different teams, so for business 
reasons it is important to have tools that are adaptable to chang-
ing needs. 

We understand your needs.  wysiwyg, courtesy of its Library that 
comprises greater than 20,000 intelligent lights, gobos, trusses, 
etc., delivers you the advantage of universality -- the ease and 
hability to work with different equipment from different manufactur-
ers so you can work on many different projects.  

wysiwyg’s planned universality also benefits those manufacturers 
and suppliers that are members of CAST’s Registered wysiwyg 
Developer (RWD) program. Indeed, wysiwyg connects to almost 
all of the major entertainment control hardware manufacturers in 
the world.  

Today there are more than 40 RWDs. They joined the RWD 
program because of wysiwyg’s power, it’s non partisan policy 

and to make their equipment an option for any one of the more 
than 10,000 production professional who use wysiwyg to plan or 
design projects.  Essentially, RWD members leverage wysiwyg 
to help get information about their products to the large wysiwyg 
market. 

“We are proud to announce that MADRIX now supports the indus-
try standard wysiwyg. This allows the wysiwyg professionals to 
plan a show using a MADRIX simulation with up to 131,072 DMX-
channels. For us and the MADRIX brand it’s important to support 
the industry standard for visualization because at the same time 
our goal is setting new standards for LED lighting control.

This implementation and other unique features of MADRIX ver-
sion 2.6b, like the Philips Color Kinetics, ROBE and INSTA proto-
col implementation, opens for us new doors especially the market 
of professional shows.

For more information about CAST’s RWD program, click  
gdensham@cast-soft.com or check out our website.   

Here are two very current examples about how RWDs harness 
the power and renown of wysiwyg...

Panalux integrates wysiwyg in new Vizilink 
Courtesy of Panalux www.panalux.biz

Panalux Lighting, an international market leader in the provision of 
lighting facilities for film and television production has recently un-
veiled a lighting control system for the feature film industry called 
Vizilink. Panalux is the union of Lee Lighting and AFM Lighting, 
now owned by Panavision, the leading force in motion pictures 
produced on film and digital media. Panavision is the world’s 
leading designer, manufacturer and supplier of precision film and 
digital camera systems for motion pictures and television, and 
winner of numerous awards, including Oscar and Emmy awards. 
In fact, over half of all films awarded Oscars for Best Picture of the 
Year since 1990 have been shot using Panavision cameras. 

The Vizilink system by Panalux is a brand new, fully integrated 
suite of bespoke products and software applications developed 
specifically for use within the Film, Television and Broadcast  
Event industries. 

Included in the new system is a modified Chamsys MagicQ, 
Military spec Tablet PC remote, handheld PC remote, custom 
engineered wireless playback remote, A3 printer for plots, Lu-
minex Artnet Nodes and a Quad core industrial PC running video 
streaming from the video assist cameras, all with full wysiwyg 
visualizations on 3 large touch screens.
 
The first two beta systems used a wysiwyg Perform on each. 
Chamsys had the live integration, patching and playback between 
wysiwyg and the MagicQ running seamlessly, so Panalux de-
cided to install wysiwyg Perform suite in all future systems. Steve 
Howard with the Broadcast and Event branch of Panalux worked 
closely with CAST Software to customize the wysiwyg library built 
into the desk. 

Vizilink allows precise, creative command over complete produc-
tion installations from a single ‘base station’ or via a range of 
unique handheld remote devices. Delivering realtime control of 
live effects and lighting sequences, Vizilink stores each perfor-
mance in an internal memory to be used later for instant set-up 
and playback for multiple takes or re-shoots.
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wysiwyg Works Virtually With Manufactures - Continued

Flightcased into a single portable unit, the system can be eas-
ily configured ready for use in less than 15 minutes and requires 
just one operator. Optimal operational flexibility is provided via 
a  family of remote controllers utilizing robust UHF frequencies, 
free  from interference or network clashes, to deliver instant, live 
access to channels.
Built around a central operating console featuring three built in 
touch screen LCD panels, Vizilink keeps users fully informed 
through detailed analysis provided by way of industry standard 
wysiwyg software, graphical interpretations of the lighting instal-
lation, plus a live video assist transmission to allow accurate on 
screen visualization.

To offer further versatility along with added peace of mind, Vizilink 
maintains comprehensive digital records of all scenes, creating 
accurate 3D plots for quick and easy access where an installa-

tion must be recreated, analysis in a digital environment such as 
post production is required or when detailed printed plans are 
needed. Available exclusively through Panalux, Vizilink is a total  
production solution for cameramen, lighting directors, gaffers and 
operators who require the ultimate control solution from concept 
to completion.

British Cinematographer magazine quoted Haris Zambarloukos 
from the British Society of Cinematographers, “Film lighting has 
needed a lighting desk that is up to date with the needs of modern 
film making and I think Panalux have finally got it right.”

Only a handful of units have been developed at this time, although 
initial reviews indicate that Vizilink will revolutionize the motion 
picture industry. Stay tuned to future issues of The Plan for up-
dates regarding sales and distribution. 

MADRIX® 2.6b sets new standards

MADRIX 2.6 has received a lot of attention at this year’s 
prolight+sound 2009. Madrix has controlled LED
applications at 8 trade show booths and one large outdoor stage. 
The new version of Windows-based MADRIX lighting controller is 
now available – MADRIX 2.6b. And this version sets new stan-
dards for LED lighting control. 

Integration of the Philips® Color Kinetics®  
(KiNetTM ) protocol:

With the newest release of MADRIX, you can now control all of 
the LED products of Philips Color Kinetics (KiNetTM). MADRIX 
communicates in the lighting installation (power / data supplies 
and Ethernet Data Enablers) via KiNET™ Ethernet, the network 
protocol engineered by Philips Color Kinetics for high-perfor-
mance lighting system control. 

This KiNET™ integration allows you to use all the advantages 
of the lighting controller MADRIX for architectural lighting, the 
entertainment market, club installations and bar applications with 
the Philips Color Kinetics LED product range. Featuring Ethernet-
based control, MADRIX dramatically simplifies the configuration, 
installation and the controlling of LED applications. 

With its scalable design, MADRIX offers the ideal controller for 
your upcoming LED project. Installed with standard Ethernet ca-
bling and network hardware, MADRIX can manage up to 131,072 
Philips Color Kinetics LED nodes or 43,690 Philips Color Kinetics 
RGB LED nodes in a very easy way.

The KiNET™ protocol also allows a data sync. The result of this 
sync with MADRIX and KiNET™ is a perfect matching image on 
huge LED installations.

Integration of the INSTA and ROBE protocol:
Additionally, the developers of MADRIX 2.6b have integrated the 
INSTA protocol for the instalight® 2022 and the ROBE protocol for 
the ROBE StageQube 324 to extend the market share. The ROBE 
StageQube 324 and the instalight® 2022 are new-generation LED 
panels. The resolution is 18 x 18 pixel at a size of 80 x 80 cm 
(pixel pitch 4.44 cm). And MADRIX can easily manage up to 134 
x instalight® 2022 or the ROBE StageQube 324. The INSTA and 
ROBE protocol data sync with MADRIX also allows for a perfect 
matching image on very large LED installations.

wysiwyg driver

wysiwyg is an Emmy and Gemini award-winning software suite 
that continues to be the top choice of entertainment lighting 
design professionals worldwide. With the release of MADRIX 2.6b 
you now get a driver that allows you to plan, design, and   pro-
gram your production in wysiwyg for up to 131,072 DMX-chan-
nels using MADRIX and LED fixtures. This association between 
inoage, the developers of MADRIX, and Cast Software - the de-
velopers of wysiwyg increases the field of application of MADRIX; 
especially for the professionals.

The new MADRIX truly is the next generation of LED lighting 
control. The developers of MADRIX spent countless hours con-
sidering things like simplicity and user interfacing…… and once 
you begin using your new MADRIX version, you’ll discover the 
incredible benefits.

inoage trade GbR - Herr Christian Hertel
Fetscherplatz 5 - D-01307 Dresden - GERMANY
Tel: +49-351-4820563-0 - Fax: +49-351-4820563-1
http://www.madrix.com
http://www.youtube.com/user/inoageDOTcom
http://twitter.com/madrix

Panalux - Continued
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In our last issue of The Plan (May 2009), CAST gave you a sneak 
preview to The Eurovision Song Contest in Moscow,  where  
wysiwyg was helping the crew prepare for an elaborate pro-
duction. The show indeed proved to be the biggest and best in 
history, breaking records in everything from number of production 
days, number of viewers and even roof load, with everyone agree-
ing in the end – “this one can never be outdone.” 

The event was broadcast live from Moscow’s Olimpiysky Arena in 
front of a live audience of 18,000 to an estimated 200 million tele-
vision and internet viewers, second worldwide only to the Olympic 
Opening Ceremonies. 

Procon Event Engineering GmbH of Hamburg, Germany pro-
vided all technical crew and equipment for the colourful array of 
42 songs, 3 opening acts, and 3 interval acts packed into 3 live 
broadcasts. Production Manager Ola Melzig oversaw the Procon 
crew of over 70 throughout their 52-day stay in Moscow. 

Here’s the schedule: May 12, Semifinal 1. 18 countries perform 
their original song live with a 32-second break between songs 
to change sets. At the end of the 18 songs, the public votes live 
via televoting during a 15-minute interval act (although countries 
are not allowed to vote for themselves). The top 10 countries go 
on to the finals on May 16. May 14, Semifinal 2. Same schedule 
as Semifinal 1 but with 19 new countries. May 16, Finals. 25 
countries – 10 from Semifinal 1, 10 from Semifinal 2, plus last 
year’s winner, Russia, and the “Big Four” countries – UK, France, 

Germany and Spain. The voting for the finals is based on points 
and the country with the most points wins the contest and will host 
the show next year.

In addition to a rigorous schedule, this year incorporated some of 
the most complex opening and interval acts in Eurovision history, 
including Cirque du Soleil and Fuerza Bruta in the final, involving 
everything from trampolines and bungee jumpers to water-filled 
swimming pools lowered from the arena ceiling with performers 
swimming and splashing over the heads of the audience.

Award-winning Lighting Designer Al Gurdon, along with the team 
from his company, Incandescent Design, was contracted to 
 

 
EUROVISION 2009: THE BIGGEST PRODUCTION IN HISTORY
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Eurovision pre-progamming studio in London

Eurovision 2009 - Moscow Eurovision 2009 - Moscow

Cirque Du Soleil swims over the audience during the interval act
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provide lighting design & front of house services for Eurovision. 
Gurdon handpicked over 750 moving lights, 250 LED lights and 
100 conventionals to compliment a mass of LED. “The goals of 
the organizers were ambitious, but everything they aimed to do 
was achieved. We had to design a huge variety of looks in a rela-
tively short time period, but it all worked,” said Gurdon.  

The rig included 72 PRG Bad Boy luminaries, 400 Martin MAC 
2000 Washes, 76 MAC 600 washlights, 135 Clay Paky Alpha  
Spot 1200s, 10 Syncrolite SX 10K fixtures, 13 Vari*lite VL3000 
and  112 Martin Atomic strobes with colour changers, to name a 
few. The roof load stood at an astounding 140 tons and the total 
stage area was over 100 metres wide, covered in over 21,000 
square feet of LED. 

All of the stage and audience Lighting was controlled through 
one Vari*Lite Virtuoso and one Grand MA Fullsize, controlled by 
Andrew Voller and Ben Cracknell. Voller and Cracknell used wysi-
wyg for the pre-programming as Essential lighting. The original 
plan was for the entire team, including video, to use one single 
ESP Vision system on a video projector. The problem was that 
with the number or lights they were using it was too slow, taking 
up to 20 hours per song to render in some cases. They instead 
moved to independent wysiwyg systems to get the best perfor-
mance and enable them to get a lot more work done. In addition, 
very little of the video content was prepared while the team was in 

London so it made no sense to previsualize these elements.
Voller explains, “wysiwyg was a huge timesaver for us, which was 
crucial for a show of this magnitude. There were 42 songs, plus 3 
interval and 3 opening acts to be prepared for the live broadcasts. 
wysiwyg’s advanced visualization enabled us to get the bulk 
of the songs pre-programmed in London to a point where they 
only required focus updates and tweaks on-site in Moscow. We 
could not have delivered such a large and complex show as the 
Eurovision Song Contest without the capabilities of wysiwyg for 
pre-programming.” 

Once all the votes were tallied, Norway’s song “Fairytale”, written 
and performed by Alexander Rybak took home top honors, mean-
ing the contest will be held in Norway 2010.

Looking back at our sneak preview, did anyone notice that we had 
posted the photo of the winner before the votes were even tallied?
 
Now that’s pre-visualization!
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Eurovision 2009- Continued

Eurovision 2009 - Moscow

Eurovision 2009 - Cirque du Soleil performing on stage
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wysiwyg showcase

Reading the email inbox at CAST Software is always fascinating. 
We constantly receive designs from Members all over the world, 
sharing their ideas and designs. We look at them all. Whether it’s 
a design used on a project or just trying some new techniques, 
we’re interested to see what you’re doing. 

We encourage everyone to email your samples and stories to 
info@cast-soft.com. If your design is selected, you will receive a 
free 3-month extension to your Membership, and your work will be 
shared with more than 15,000 Members via The PLAN.

In this issue, we’d like to feature some renderings from Richard 
Goode at Thomas Lighting Canada, illustrating some very diffe-
rent, yet very helpful ways to use wysiwyg. 

1) Strand Selecon at work. Two level theatre lobby area with 
small temporary stage for corporate function.

2) Small school stage. Proof of design that 6 fresnels and 4 ERS 
can light a stage with the correct products and placement. Previ-
ously this was all guesswork with 2D electrical plans.

3) Theatre House lighting. Proof of concept using 8100 lumen 
CYM downlights architecturally. White light is necessary but add 
color for theme or special events.

4) Office lighting plan. Example showing how wysiwyg does 
architectural lighting. Used live to demonstrate load shedding for 
energy saving either by occupancy sensing, daylight or astro-
nomic events.

Just more proof that wysiwyg can do almost anything and this is 
why it is the industry standard.

Keep those great ideas coming -- your designs and ideas on the 
pages of The PLAN. 

Remember that any time you send creative work to CAST we 
need your full permission to use it. Be sure to include your writen 
permission in your email -– the date, your name and email ad-
dress; — as well as any restrictions or special uses, and any 
special instructions.
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wysiwyg design has reached new heights at Six Flags New 
England on the recently remodeled roller coaster, BIZARRO. This 
newly-enhanced roller coaster offers high-speed thrills combined 
with high tech special effects in a unique story-telling adventure. 

Six Flags is the largest family theme park and waterpark in New 
England, with 235 acres and 46 attractions. The park dates back 
to 1840, originally under the Riverview Amusement Park name 
and re-branded Six Flags New England in 2000.

Lighting Designer and System Consultant Tony Hansen of Techni-
Lux in Orlando, Florida created an electrifying lighting scheme 
for the thrill ride using wysiwyg and a CSP video to prove the 
concept and help illustrate the animation possibilities. Techni-Lux 
was approached for the project based on recommendations of 
their expertise in themed attractions. Hansen says, “wysiwyg 
was the tool we used to help demonstrate the ability of our design 
concept and ultimately gain the trust of the client that our concepts 
were feasible in their environment and requirements.” 

The ride is themed around the DC Comics character Bizarro, 
best known as a strange Superman-like creature from a parallel 
Earth known as Htrae where daily life is the exact opposite of 
Earth. Htrae’s superhero, Bizarro, possesses traits and powers 
the opposite of Superman, such as freeze vision, heat breath, 
and  x-ray hearing. Six Flags ride designers not only wanted 
to design an exciting coaster, but also wanted to take travelers 
through Bizarro’s world.

The coaster is floorless, giving riders the sensation of flying as 
their feet dangle above the track. The three minute and fifteen 
second adventure takes riders through a 146-foot (48.5-metres) 
climb and speeds up to 61 miles-per-hour (100 kilometers-
per-hour) through Bizarro’s freeze vision “cool zone.” The rush 
continues through seven loops — including 114-foot (35-metres) 
vertical and 96-foot (30-metres) dive loops — blasting past bursts 
of Bizarro’s fire breath and racing by bizarre scenes and illusions. 

The mind-boggling 3,985-foot (1.2-kilometer) twisting journey of 
storytelling and high-tech elements ends by sending riders head 
first into a spiked-shaped Auger of Doom, set inside interlocking 
corkscrews. Throughout the entire journey, riders experience the 
adrenaline rush with special effect lighting and heart-pounding, 
on-board audio taking them to a whole new level of imagination. 

The project required the use of high-powered LEDs to be visible in 
full sunlight and still be durable enough to withstand the constant 
vibration caused by the coaster train passing at over 60mph 
(100kph) every few minutes. Hansen designed an “un-Earthly” 
tunnel using 105 Pulsar Chromastrip X3TC units to create a 
colorful passageway. The lighting concept took quite a bit of 
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wysiwyg BRINGS BIZARRO TO REALITY
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Bizarro Roller Coaster at Six Flags

Photo of Bizarro Roller Coaster

Rendering of the Bizarro Roller Coaster Project
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design and testing to convince the client that LED technology was 
up to the requirements for daylight viewing. Once the project was 
approved, all of the pre-programming was done on ShowCAD 
Artist using the wysiwyg plug-in to previsualize the animations 
and coordinate the sequence timings. Hansen concludes: 
 “As they say ‘A picture is truly worth a thousand words’ and an 
animation is worth a job.” 
 
This is far from the first project where Techni-Lux and Hansen 
have used wysiwyg. Other projects include the Castle at Walt 

Disney World Florida, Brainwash & Disco H2O rides at   Wet-n-
Wild Florida, Jungle Boogie Ride at Chula Vista resort Wisconsin 
Dells, WI, as well as theme rides all the way to Copenhagen and 
Belgium. It was also used on the Parnelli Awards 2005-2009. 
More information can be found at www.techni-lux.com

Bizarro is just another one of the variety of jobs that can be 
accomplished, and won, using wysiwyg as your tool of choice. 
Great job, Tony!

Bizarro - Continued

Photos of Bizarro

A video of the thrill ride can be viewed at http://www.techni-lux.com/default.aspx?tabid=106. 
Additional videos are available at www.seetheride.com.
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wysiwyg RAVES IN GERMANY
 

Martin Kuhn Lighting Design in Berlin, Germany recently used 
wysiwyg to deliver a cutting-edge design to MAYDAY Massive 
Moments in Westfalenhallen Dortmund, Germany, north of 
Cologne. The event, held 30 April 09, was hosted by “imotion”, 
the producers of the MAYDAY which is considered the “mother 
of all raves”, the massive techno parties started long ago and 
are gaining popularity every year. Popular indeed, with Massive 
Moments seeing attendance over 25,000 and including 54 DJs 
and live acts with a massive lighting and sound scene that you 
just have to see to believe.

Kuhn used wysiwyg to figure out the 3D proportions of all the 
architectural elements in the set, as well as the LEDs, plasma 
screen and the relationship to all of the lighting behind the stage. 
“I like to build with depth, and it just makes my job so much 

easier if I can preview this,” explains Kuhn. “The venue is quite 
large and the audience seating surrounds the dance floor in the 
rafters, up to a height of 50 feet (15 meters), so it’s important to 
check the view from many angles to be sure the design works.” 
He adds, “If it is difficult even for me, without a preview/render to 
really work it all out, how would the client be able to grasp it? He 
doesn’t understand drawings. He wants renders shortly before the 
event and they then go online. So they better be decent!” 

Kuhn didn’t use wysiwyg for preprogramming as much as for 
completing massive amounts of paperwork and, most importantly, 
for the renders. “So I was happy to be able to do it with R23,” he 
said.  Kuhn also points out that it is possible to adjust how the 
render appears in wysiwyg (especially useful for printing really 
high quality output), or to export it for touching up or adding 
special effects for eye-popping images. 

Additional background information photos and videos on MAYDAY 
Massive Moments can be found at:  
http://www.nature-one.de/2708.0.html (in German). 

Photos: Copyright Amanda Holmes
Kuhn’s website www.mkld.de

Photo Image of Mayday Rave 2009
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wysiwyg Rendering of Mayday Rave 2009

wysiwyg Rendering of Mayday Rave 2009

Tip:  Sometimes, especially up close, “sawtooth edges” can appear in a render 
or picture.  In order to smooth them out, before starting the rendering be sure to 
ENABLE Anti-aliasing in the last step of the Render Wizard.  Remember that, 
if taken to the extreme, anti-aliasing can smooth “sawtooth edges” to the point 
where the edges become too blurry and unsightly.  Rule of thumb — the higher 
the resolution of the rendering the higher the Anti-aliasing setting should be.  
Look for further tips on using Anti-aliasing in the next PLAN!

http://www.nature-one.de/2708.0.html
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MuchMusic Video Awards
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The hugely popular MuchMusic Video Awards, which was held 
and broadcast live to millions worldwide on Sunday, 21 Jun 09 
from a very crowded Queen St in Toronto, Canada.  With more 
than 35,000 fans in the street, this is one of the premier fan-based 
events in the world, giving fans the experience of a lifetime by 
putting them as close as humanly possible to their favorite artists 
and celebrities at both live concerts and a red-carpet special 
beforehand. 

At the MMVAs, the audience is the priority, with many fans seated 
as close as one foot from the stage. This year featured top ce-
lebrities including Lady Gaga, Jonas Brothers, Kim Kardashian, 
Blackeyed Peas, Nickelback and Girlicious, among many others.

Lighting Designer Dave Fairfield of MuchMusic worked with Chris 
Newkirk from SCREAM!Lab consulting on this years MMVAs with 
an eyepopping lighting scheme all about LED’s. Since the team 
would be beta testing wysiwyg R24 on this momentous event, 
CAST made sure that every one of the LED fixtures that Fairfield 
and Newkirk wanted to use was rebuilt ready for R24 beta to use. 
MuchMusic does all their drawings with wysiwyg.

Newkirk, AKA “Dr. DMX”, was responsible for the creation of 
the DMX data system, console links, routing, etc. They used 14 
primary DMX universes from GrandMA/NSP’s, as well as an 
additional 8 universes coming from media servers. Fairfield at 
MuchMusic built the wysiwyg model with all fixtures.

Newkirk received the file and patched all the fixtures in wysiwyg, 
which generated the master patch list. It was sent to Christie Lites, 
so all fixtures arrived pre-addressed and labeled. Also, as there 
were small changes along the way, Newkirk had his machine   
running wysiwyg at his primary dimmer area and updated  
​​wysiwyg and his console patch as he worked. 

“It’s saved me HUGE amounts of grief,” he said, “I’ll be running 
wysiwyg in    tandem with the system as a digital check, so I can 
see if I have data bus problems or system issues, should any is-
sues arise. And the show is live to air, so the whole data system is 
redundant with A/B switches to switch over.”

The fixture list included 30 Martin Mac 2000 Wash, 20 Martin 
Mac 300, 104 Martin Mac 600NT, 47 Martin Mac 700, 144 Color 
Kinetics Color Blast, 12 Altman Focusing Cyc 1, 12 Atomic 3000, 
22 Color Block M9, 350 OctoStrip, 68 76-inch Ministrip, 6 Par 56 
Borderlight 6’, 74 PAR 64, and 78 Source 4 750, for a total of over 
960 fixtures.

The lighting and staging were a perfect backdrop to watch Nick-
elback nab three trophies in front of thousands of frenzied fans, 
alongside other show highlights such as Lady Gaga shoot pyro 
out of her costume and see Twilight actors Taylor Lautner and 
Montreal’s Rachelle Lefevre.

More behind-the-scenes action http://mmva.muchmusic.com/

MuchMusic Video Awards Production Crew

MuchMusic Video Awards Stage

Black Eyed Peas Performing on Stage

MuchMusic Award Venue on Queen Street - Toronto
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BlackBox is Coming - Are you ready?
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As regular readers of The Plan, you’re all aware of the advances 
and achievements of wysiwyg and also our pre-visualization and 
design software, Vivien—Event Designer, spawned from wysiwyg 
and launched in Apr 05, for venues, event planners/designers, 
and those producing meetings and special events (galas, awards, 
conferences, weddings, training sessions, etc.)

Last year, the entertainment production market place began to talk 
about a new CAST innovation – BlackBox.  We even gave a few 
sneak previews last year at PLASA and LDI. 

By leveraging our 15 year development history and knowledge 
of pre-visualization in 3D, CAST designed BlackBox (US Patent 
pending) to use a new wysiwyg.bb proprietary “CAD-type” soft-
ware which defines the parameter (to establish “0”0”0”) and any 
fixed objects or geography in the space, calculate of the absolute 
position of moving and stationary objects, and communicate in/out 
data in realtime.  

Our Core Technology
From the beginning, wysiwyg made it possible to pre-visualize 
(virtually) the set and stage lighting designs before installing any 
real hardware, lights or even occupying the venue, which in-
creases productivity and reduced production costs for End Users 
(production professionals g productions).  Green-responsible 
production professionals and venues also know that wysiwyg’s 
powerful pre-cueing and pre-visualizing capabilities can be used 
offsite on a PC and that delivers significant energy savings and 
reduces the carbon footprints of venues/productions. 

wysiwyg previsualizes the plot in 2D, 3D wireframe and time-of-
day Shaded View, and automatically generates the lighting plots, 
equipment schedules, pipe-tapes, colour cut lists, gobo lists and 
anything needed to make the show happen.  wysiwyg has been 
morphed into a comprehensive software production design suite 

- the first live, realtime 3D — 6D positioning  
and communicating hardware/software,  

plug-and-play technology solution
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of tools which incorporates virtual realtime pre-visualization of 
lighting, motion, and media content used primarily for pre-show 
work, and that processes data and communicates with control-
lers of lights, moving and static, as well as listening to motors 
that move scenery and replicating streaming media content (for 
coordinating with lights and other controllers).  Via CAST’s devel-
oper program, wysiwyg is used by a continually growing number 
of hardware manufacturers and entertainment control systems 
for adding visualisation to hardware, as well as for testing new 
conceptual lighting fixtures, robotic/automated hardware and new 
production technologies. 

BlackBox -- New Technology| 
BlackBox will use a new proprietary file type wysiwyg.bb (128 bit 
encryption) and utilising our proprietary 6D positioning protocols 
defining the parameters (to establish “0”0”0”) in relation to any 
or several moving or fixed objects, or geography in the “space” 
(as uploaded in wysiwyg.bb).  BlackBox will run on a high-speed 
communications server-type computer likely using XP (64 bit 
embedded) or other viable OS.  It will be an all-in-one positioning 
and bi-directional communications and data distribution system 
that enables all technologies of all control or robotic devices to be 
connected together (plug and play – open systems architecture) 
through BlackBox.  

Live realtime tracking data from wireless and/or wired sensor In-
put Devices like RFID, SONAR, RADAR, Infra Red, stereoscopic 
cameras (with or without thermal imaging), or any other 3rd party 
sensing device, as well as programmed streaming positioning 
data from any controller or sensor operating moving objects, or 
programme controllers for any electromechanical device (oper-
ated either automatically or manually), is received in BlackBox 

which then calculates the absolute positioning of stationary and 
moving objects in the space and then distributes this data to 
whatever 3rd party technologies/controllers want it. All of this 6D 
spatial moving information between all devices is being translated/
specified to run at a minimum of 50MHz.

For the highly automated, hi-tech entertainment industry, using 
BlackBox means that formerly autonomous hardware/controller 
technologies can interact and cue off each other in live realtime, 
or trigger pre-programmed commands (in one or several depen-
dent devices), based on the dynamic positioning of moving or 
stationery objects, to instruct moving lights, robotic cameras, au-
tomation systems, multi-media servers – even to deliver positional 
information for spatial audio.

The software can be used for decision aid/support to identify/
predict for intrusion detection/prevention and to warn about intru-
sions, unexpected movements, or potential collisions (virtual/
augmented reality) in the designated area within the prescribed 
boundaries, and to exempt or prevent a collision of objects by 
using anti-collision boundaries set in BlackBox to trigger pre-
programmed avoidance alerts to all connected technologies if 
something isn’t right or working as expected.

While early days, entertainment production professionals claim 
that BlackBox will revolutionize the industry. CAST believes that 
in the future, BlackBox will also have additional important, vital 
uses for military, aeronautic, security (perimeter, border, internal), 
safety, medical, health, construction, and logistics applications. 

BlackBox will be a powerful, fast, and robust (new code + the 
proven proprietary intelligence of wysiwyg) to which, with the right 
DLL, any or several sensor, tracking, hardware/controller tech-
nologies and electromechanical device can connect/interconnect 
(Input or Output) to share live, realtime positioning and other data.

CAST seeks Partners 

CAST is always interested in discussing opportunities to col-
laborate on R&D projects with big vision partners with significant 
strength/prominence/dominance in their industry segment.  For 
more information, please contact either : 
gdensham@castgroupinc.com or bfreeman@castgroupinc.com
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BlackBox is Coming - Continued
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Just a few samples of wysiwyg’s work: The Queen’s Jubilee at Bucking-
ham Palace, numerous Olympics ceremonies, multiple Cirque du Soleil and 
Disney shows, concert productions (including U2, Elton John and Eurovision 
2009) and gala events like the 2008 Nobel Peace Prize Ceremonies/Banquet. 
wysiwyg is used by many large theatrical venues like the Royal Opera 
House in Covent Garden, the new Four Seasons Centre for the Performing 
Arts in Toronto, and the Sydney Opera House.  As well, wysiwyg is used 
extensively by major film productions such as the Harry Potter series, Spider-
man, X-Men, and Charlie and the Chocolate Factory, Alexander the Great. 

Cirque Du Soleil - “O”

Cirque Du Soleil - Fuerza Bruta
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wysiwyg Tips & Tricks 
by Dany Tancou
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TIP 1 - An in-depth look at simulating truss movement in wysiwyg

In this month’s tip, you will learn how to simulate the movement of a length of truss that would be hung from two motors in real life. 
Since the motors are controlled independently, they can be used to raise/lower the truss, as well as tilt it around its center point.

The key to simulating this movement is to attach the truss to a Rotation Axis, which is then attached to a Linear Axis. Note that if this is 
lighting truss, you must hang the fixtures on it and focus them (in the case of conventionals) before you attach the truss to any axes.

Truss details for this example 

In this example, we will use truss that has the following properties:
length: 16’•	
minimum trim height when horizontal:  20’ •	
maximum trim height when horizontal:  30’•	
at any time, the truss will be able to tilt up to 45º clockwise and/or counter-clockwise; when fully tilted, either end of the truss will •	
be able to “dip” below the minimum horizontal trim height of 20’
it will hold two moving lights and two conventionals. (The two conventionals will be used to light the subject (a 6’ ladder) when •	
the truss is horizontal at minimum and maximum trim respectively. The two moving lights can be used at any time, since      
wysiwyg has the ability to “track” static focus positions and update fixture positions automatically.)

Before you begin

Before you start, perform the following general setup or create something else entirely. For details on any of these steps, see the  
wysiwyg online Help or Reference Guide.

In CAD mode, start a new file and insert a Black Box venue.1.	
Insert a 6’ Ladder from the Library a few feet up from the middle of the venue, on the floor.2.	
Draw a focus position in the middle of the ladder roughly 3’ off the floor.3.	
Assemble two sections of truss (for example, two 8’ sections of Christie 12” Box Truss) at a trim height of 20’.4.	
On the truss, hang two ERS fixtures (for example, 14º and 19º ETC Source 4s) and two moving lights of your choice (for ex-5.	
ample, Martin Mac 500s).

Focusing the fixtures

Once you hang the fixtures, you must focus the ERS fixtures as per the requirement set above. The 19º fixture will light the ladder when 
the truss is horizontal and at minimum trim, while the 14º fixture will light the ladder when the truss is horizontal and at maximum trim. 

Dany Tancou
 * All the pictures that illustrate this article are from wysiwyg Release 24, your project might look a 
bit different if you are using Release 23.
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To focus the 19º fixture

Select the Focus Position that you drew in the middle of the ladder (step 3 above).1.	
Click Tools > Quick Focus2.	 .
Click on the 19º ERS fixture.3.	

Result:  The fixture now points at the Ladder.

To focus the 14º fixture

Before you focus the 14º fixture, you must temporarily move the truss to the 30’ trim height. The easiest way to achieve this is with an 
Absolute move, as described below.

Select the truss.1.	
Click 2.	 Edit > Move.
Without clicking, type 3.	 @0,0,10’ and press ENTER.

Result:  The truss moves up by 10’.

Focus the fixture:

Select the Focus Position that you drew in the middle of the ladder.4.	
Click Tools > Quick Focus.5.	
Click on the 14º ERS fixture.6.	

Result:  The fixture now points at the Ladder.

Move the truss back to its minimum trim position:

Select the truss.7.	
Click 8.	 Edit > Move.
Without clicking, type 9.	 @0,0,-10’ and then press ENTER.

Note that these steps (i.e. focusing conventional fixtures with the truss at different heights) replicate those performed in real life. Since 
these fixtures can only be focused manually, they must be focused from the position at which they are going to be used.  

Your setup should now look something like the following screenshot:

Tips & Tricks - #1 Continued
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Drawing the Axes
Now you must draw the two axes used to simulate the truss moving and tilting. As noted above, to simulate this movement, the truss 
must be attached to a Rotation Axis (which simulates tilting), which is then attached to a Linear Axis (to simulate the up/down move-
ment).  

To draw the Rotation axis

In CAD mode, switch to Front View. 1.	
From the Draw menu, select 2.	 Axis > Rotation Axis.
Type a name for this axis (for example, “Truss_Tilt”).3.	
Click 4.	 Tools > Snap > Endpoints. (Endpoint snap ensures that the “Tilt” Rotation Axis is placed at the exact mid-point of the 
truss, where the two pieces meet.)
Hover your cursor at the top edge of the truss, where the two pieces meet, and wait for it to snap into place, as shown below:  5.	

Click to place the Rotation axis.6.	
           Result: The Rotation axis appears in your drawing.  

To draw the Linear axis

Still in Front View, from the Draw menu, select 1.	 Axis > Linear Axis.
Type a name for this axis (for example, “Truss_Move”).2.	
Click 3.	 Tools > Snap > Endpoints.
Again, hover the cursor at the top edge of the truss, where the two pieces meet. Wait for it to snap into place, and then click to 4.	
begin drawing the Linear axis. 

Before clicking again, click 5.	 Tools > Ortho > Z Axis.
Move the mouse towards the top of the screen (a line will begin to extend upwards), and then type 6.	 10’ and press ENTER.
Right-click and select 7.	 Finish Axis.

Result: The Linear axis appears in your drawing, as shown in the graphic below:

Tips & Tricks - #1 Continued
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Attaching the Truss to the Axes

Before attaching the truss to the axes, you must make sure that the truss is able to tilt both ways, as per the requirement above. When 
working with a Rotation axis, the rotation of anything attached to it begins at the tip of the arrow and continues counter-clockwise until 
it reaches the tip of the arrow again.  As such, if you were to attach the truss to the Rotation axis in the position shown above, the truss 
would never be able to tilt clockwise.

Therefore, you must rotate the truss by -43.2º around the same end point where you inserted the Truss_Tilt axis. If you do not perform 
this step, due to the way in which wysiwyg uses axes, you will only be able to rotate/tilt the truss counter-clockwise.  

To maintain the fixture focus position

There is one last thing left to do before you rotate the truss to set its rest position:  you must make sure that the two conventional 
fixtures maintain their focus position even after you rotate the truss. Failure to do so before the truss is rotated will result in loss of the 
fixtures’ Pan and Tilt information. 

Select 1.	 one of the fixtures.
        IMPORTANT: Do not select both fixtures at the same time.

Right-click and select 2.	 Properties.
Click the 3.	 Fixture tab.
On the 4.	 General sub-tab, from the Focus Position drop-down, select None.
Without touching anything else5.	 , click OK.
Repeat steps 1–5 for the other fixture. 6.	

Result: Even though you removed the association with the “Ladder” Focus Position, the fixtures have maintained the Pan and Tilt 
values that were assigned to them when they were initially associated with this Focus Position.

To rotate the truss

Still working in Front View, select the truss.1.	
From the Edit menu, select 2.	 Rotate.
Click 3.	 Tools > Snap > Endpoints.
Hover the cursor at the top edge of the truss where 4.	
the two pieces meet. Wait for it to snap into place, 
and then click to set the base point for the move.
Type 5.	 -43.2 and press ENTER.

Result: The truss rotates clockwise. The conven-
tional fixtures are no longer lighting the ladder, which is 
fine because the requirement is that they only do so when 
the truss is horizontal. They will light the ladder once you 
start setting up Looks in Design mode.  

Now that the truss has been rotated and you are about to 
attach it to the axes, it must remain in this position oth-
erwise it will not move properly.  This should not present a 
problem, except when printing the plot.  Printing with the 
truss in this position would make the plot hard to read, to say 
the least.  Therefore, it is recommended to set up the truss 
for movement only after the design has been finalized (and 
the plot was printed).  Alternately, you could keep two copies 
of the file, one for previsualization and one for printing.

Why use the -43.2º angle?

It is known that wysiwyg’s Scenery Designer Tool (in Design mode) only uses whole 
numbers, from 0 to 100--it does not use decimal values. Therefore, to use this Designer tool 
effectively, you must “translate” the rotation angle (0º to 360º) into numbers that the tool can 
handle (again, 0 to 100).  

If the Scenery Designer Tool could use decimal values, you could start with the truss’s rest 
position at -45º, and, to tilt it to  a perfectly horizontal position  (i.e.to 0º) set the position for 
the rotation axis in Scenery Designer tool to 12.5.  Since this cannot be done, another solu-
tion must be devised.

It is known that a 45º rotation is equal to one eighth of a turn (360º / 45º = 8) and that one 
eighth of 100 is 12.5 (100/8=12.5).  Since a position of 12.5 is not achievable on the Scenery 
Designer Tool, you must compensate in the angle of the truss’s rest position.  
 
To determine what this angle is, use cross-multiplication (to solve for X):  since you know 
that a position of 12.5 on the Scenery Designer Tool would rotate the truss from -45º to 0º, 
what angle do you need to start at to get to the same end angle with a position of 12 on the 
Scenery Designer Tool?  

In other words, 12.5 is to 45º as 12 is to Xº.  To solve for X, multiply 12 by 45º and divide by 
12.5:  

X = 12*45º/12.5 = 43.2º
 
Hence, making the truss’s rest position -43.2º and giving it a position of 12, will bring it to a 
perfectly horizontal position.

Tips & Tricks - #1 Continued
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To attach the truss to the axes

Finally, you attach the truss to the axes, so you can start to play with the moving truss in Design mode!

Click to select the truss, and then right-click and select 1.	 Properties.
On the General tab, from the 2.	 Attach to Axis drop-down, select the Rotation axis you created (for example, “Truss_Tilt”).
Click 3.	 OK.
Click to select the Rotation axis, and then right-click and select 4.	 Properties.
On the General tab, from the 5.	 Attach to Axis drop-down, select the Linear axis you created (for example, “Truss_Move”).

Click OK.
 
 
Creating Looks in Design mode

Now that you have set things up, switch to Design mode and create a few Looks to prove that the truss can move as required above. 
For details on creating Looks, see the wysiwyg online Help or Reference Guide.

Before you begin, from the Design menu, click Intensity Tool, Focus Tool, and Moving Scenery Tool.

Look 1- Low Horizontal: Start by creating a new Look called 
“Low Horizontal” with a Fade Time of 10 and the following param-
eters:

Intensity:  Movers @ Full, 14º ERS @ 0, 19º ERS @ FULL»»
Focus:  Movers @ Ladder»»
Axis:  Truss_Tilt @ 12, Truss_Move @ 0»»

Look 2- High Horizontal: Create a new Look (do not Clone the 
previous one) called “High Horizontal” with a Fade Time of 10 and 
the following parameters:

Intensity:  Movers @ Full, 14º ERS @ FULL, 19º ERS @ 0»»
Focus:  Movers @ Ladder»»
Axis:  Truss_Tilt @ 12, Truss_Move @ 100»»

Keeping the Ladder Lit

As you move between these Looks and the suggested Looks below, you will notice that the moving lights drift away from the ladder, and only fully lock back on it when the 
truss has finished moving. This is not a problem with wysiwyg, per se, but simply the way it works. CAST’s new product, BlackBox, will enable you to constantly keep the 
ladder lit by moving lights even while the truss they are hanging from is in motion!

Tips & Tricks - #1 Continued
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Test the Looks
Click on the “Low Horizontal” Look. The truss should begin to move down, while the moving fixtures stay more or less “locked” on the 
ladder. The two ERSs crossfade, so that the 19º fixture is at full (and focused on the ladder) when the transition/move completes.  

More suggested Looks

Here are some ideas for a few other Looks, all with a Fade value of 10. (Naturally, increasing this value will create slower moves, while 
decreasing it will create faster moves.) When creating new Looks that contain motion, it is recommended to always create a new Look, 
as opposed to cloning an existing Look.

“Low Full CW Tilt”:

Intensity:  Movers @ Full, 14º ERS @ 0, 19º ERS @ 0»»
Focus:  Movers @ Ladder»»
Axis:  Truss_Tilt @ 0, Truss_Move @ 0»»

“Low Full CCW Tilt”:

Intensity:  Movers @ Full, 14º ERS @ 0, 19º ERS @ 0»»
Focus:  Movers @ Ladder»»
Axis:  Truss_Tilt @ 24, Truss_Move @ 0»»

“Mid Half CCW Tilt”:

Intensity:  Movers @ Full, 14º ERS @ 0, 19º ERS @ 0»»
Focus:  Movers @ Ladder»»
Axis:  Truss_Tilt @ 18, Truss_Move @ 50»»

“Mid Half CW Tilt”:

Intensity:  Movers @ Full, 14º ERS @ 0, 19º ERS @ 0»»
Focus:  Movers @ Ladder»»
Axis:  Truss_Tilt @ 6, Truss_Move @ 50»»

ISSUE 25 /JULY 2009
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To download the sample file for this tip, please click here.

http://theplan.wysiwygsuite.com/issue25/Tip1_July2009.wyg
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TIP 2 - In-Depth Look at Release 24’s Consolidate Mesh Feature
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Tips & Tricks- Continued

In the May issue of The Plan, the second tip described how to optimize performance in files by creating new Library Items. At the time, 
we promised that Release 24 would feature a new and even more efficient way to optimize files called Consolidate Meshes.  

While the two methods are similar in what they achieve, consolidating meshes has a very large advantage over creating new Library 
Items: the size of your file does not increase. 

To help you use this new feature, Release 24 also offers a new Visual Style (Bounding Boxes) that enables you to easily determine 
which objects need to be optimized and which do not.  

The Consolidate Mesh feature helps increase performance in Shaded Views by enabling you to “transform” complex objects made up 
of multiple polygons into objects that behave as a single entity. wysiwyg, like AutoCAD and all other similar applications, handles single 
objects comprising many components much better than it handles each of the components separately. In other words, a file that con-
tains twenty risers each made of six surfaces is less efficient, and thus slower, than a file that contains the same twenty risers combined 
into a single object.

The easiest way to determine which objects in your scene to consolidate is to enable the new Object Bounding Box visual style (avail-
able in Release 24) on the View Options tab, as shown below:

http://theplan.wysiwygsuite.com/issue24/ThePlan_%20May09-Tips&Tricks.pdf
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Tips & Tricks - #2 Continued

Once enabled, bounding boxes appear around all items in the Shaded view. Those objects with a high number of bounding boxes are 
all candidates for having their meshes consolidated.  

To optimize your file by consolidating meshes, it is best to work in Quad (CAD mode) because it is much easier to look at what needs to 
be consolidated and have the ability to select and consolidate the object(s) right away, than to flip back and forth between Shaded and 
Wireframe views.

Once you determine which objects to consolidate, perform the procedure below. 

To use the Consolidate Mesh feature

In a wireframe view, select the object that you want to consolidate.1.	
From the Tools menu, select Consolidate Mesh.2.	

Result: A message box appears, confirming that the operation is complete, and displaying the number of polygons that have been 
removed from the file.

Click OK. The item is now consolidated into an object, which 3.	 wysiwyg “sees” as a single entity.

Helpful Tips

It is important to learn to use this feature properly. Let’s take as an example 
a theatre that includes audience seating comprising chairs from the wysiwyg 
library. Since these objects are already optimized (i.e., wysiwyg sees them as 
single entities, not as separate components made up of armrests, backs, legs, 
and so on), there is, seemingly, nothing left to consolidate. 

However, all these seats were placed in the theatre individually, whether they 
were copied & pasted, arrayed, and so on. As a result, wysiwyg still considers 
them to be individual entities. To optimize this file, therefore, you could select 
all the seats (or, if more control over overall placement is required, select all the 
seats within a seating section) and Consolidate them into one large object.

A similar example involves seats that were created in AutoCAD or SketchUp and imported into wysiwyg. In such a case it is recom-
mended that you consolidate a single seat, copy and paste it around or array it to create the seating sections, and then consolidate the 
sections (or all the seating at once) to further optimize the file. If, on the other hand, the imported AutoCAD/SketchUp file contained all 
the seating in the theatre, I recommend consolidating the sections (or all the seating) directly, instead of consolidating individual seats.

Since objects to consider for consolidation can be virtually anything, it is pointless to provide a list of what to look for. The best practice 
is to always turn the Bounding Box view style on once the venue/set in your file is nearing completion (and before you start defining 
hang structures and hanging fixtures), and then optimize as much as possible.

Consolidated Mesh and Improved Shaded View Performance

Once you have consolidated various objects in your file, you will 
immediately notice that the Shaded view has become faster. To 
test this, click and drag within the Shaded view. 

Another way to see the improved speed is to enable View Statistics 
on the View Options tab. If you do so before you start optimizing, 
there is a good chance that the View Complexity will read ‘High’ 
or ‘Very High’. Once you’ve consolidated a few objects however, 
not only will the View Complexity drop to ‘Medium’ or ‘Low’, but the 
Number of Objects will also decrease dramatically while the FPS 
counter will 

Even More Noteworthy Tips
 
Objects that have been modified with wysiwyg’s Boolean tools need not be consolidated since all Boolean operations perform the consolidation automatically.

Objects that have been consolidated cannot have Boolean operations performed on them. This is by no means a flaw or a limitation of wysiwyg’s Boolean tools, but simply the way in 
which 3D models work:  when an object is consolidated, its underlying geometry is modified in such a way that no further geometry changes may be performed on that object.

If an object to which a texture has been applied is consolidated, the texture will most likely not behave correctly. This is, again, due to the object’s underlying geometry having been 
altered in such a way that it cannot support textures properly. To maintain proper texturing AND have the file perform well for pre-visualization, the only thing to do is create a copy of 
the final file, optimize the copy, and then use the optimized file for pre-programming purposes and the original file for screenshots and/or renderings


